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Purpose 

This latest release of IDEA significantly advances the functions and features available while still 
maintaining IDEA's world-renowned ease-of-use. 

 
 

System Requirements and Installation Information 

Please refer to the installation guide you received with the installation package from your 
CaseWare Partner. 

 
 

New Features and Enhancements 

This release includes the following new features: 

 
 

Feature ID Description 

CaseWare Working 
Papers 

13284, 13061, 
13285 

IDEA lets you collaborate with an installed, supported version of CaseWare Working Papers. You can send IDEA 
databases (as a database file or PDF) and other project files directly from IDEA to a CaseWare Working Papers Client 
folder. 

Delimited Extended 
Import 

13803 IDEA can now import CSV files that use the RFC 4180 format. 

The Text import and Advanced Record Definition Editor were updated to support Delimited Extended imports. 

Smart Actions 10916, 13282, 
11622, 11624 

Smart Actions are specialized IDEAScript macros that launch your default web browser or open a web tab in the Main 
window (depending on the Smart Action script). 

Use Smart Actions to dynamically look up information on a single Character field cell value or multiple Character field 
cell values within the same record without manually copying and pasting the values into another application. 

Web Tabs 12306, 13388, 
12397, 12398, 
12611, 12840, 
13386 

The Main window (formerly the Database window) in IDEA displays database tabs and web tabs. 

Database tabs appear when you open IDEA databases. 

Web tabs let users have a unified experience when accessing IDEA's web-based resources, such as IDEA Lab and 
CaseWare Passport. You can now access those websites within a web tab in IDEA. 

 

This release includes the following enhancements to existing features: 
 

Feature ID Case Description 

Data Files 13100,  More recent dates appear in the Samples and Tutorial Managed projects 

 13309 data files. 

  Due to these changes, the IDEA Tutorial, Report Reader Tutorial, and 

  Advanced Statistical Methods Case Study guides have been updated. 

Delete Database 11406  You can now delete the active database without closing it first. 

Documentation 13208 CAS-57066- 
M0P0K2 

Installation Guide 

The Installing IDEA section now includes a step detailing product registration or connecting to a CaseWare 
Network License Server (NLS). 

 13549, 
14582 

 Installation Guide 

The Hardware Requirements section now includes a note about running IDEA on an Apple macOS. 

  In the Technical Notes section, the Project Overview bullet indicates that there can be Project Overview 
information loss if IDEA 12 Managed projects are opened in IDEA 11.x and earlier. 
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Feature ID Case Description 

 11354 CAS-48500 CaseWare Network License Server Installation Guide 

The Technical Notes section indicates that you should not install CaseWare Working Papers and IDEA on the 
same machine as CaseWare Network License Server (NLS). 

13044  IDEA Tutorial 

The document has been updated to follow an analytics workflow. 

Equation Editor 8056 CAS-36284 Field statistics are automatically calculated when @FieldStaticstics is used in the Equation Editor. You are no 
longer prompted to calculate the field statistics. 

9025  You can now use custom functions from the Local Library in your equations without copying them to your 
Current Project Library first. 

893, 
9026, 
9092, 
11669, 
13747 

CAS-12926, 
CAS-61767 

The Custom Functions dialog box includes the following enhancements: 

create custom functions and Python custom functions identify the custom function type 

format the help text 

use Time fields as input and output parameters 

categorize the custom functions and Python custom functions into similar groups used by the 
@Functions 

Excel Import 14132  To improve the user experience, when you import an Excel source file that contains more than 5,000 records, 
the preview limitation warning message appears in the Microsoft Excel import dialog box and not as a separate 
error message. 

Exporting 
Databases 

13318, 
14386 

 Text Delimited exports are now saved as CSV files instead of DEL files. 

Existing IDEAScript macros that set the database export type as DEL will still work. 

IDEA Cloud Share 4460 CAS-48275 You can now connect to a CaseWare Cloud environment that uses two- factor authentication. 

11033 CAS-46981 The Connect to Cloud login page now lets you select an option to keep you signed into the cloud for a period of 
time. 

11424 CAS-48272 You can now connect to a CaseWare Cloud environment that uses single sign-on. 

11569  IDEA Cloud Share now detects custom Local Library folder locations. 

11700  A more meaningful message is displayed if IDEA Cloud Share cannot find the Local Library folder. 

13342  A more meaningful message appears when a new entity has not yet been configured for IDEA. 

13421  Security enhancements were made to IDEA Cloud Share's implementation of WebView2. 

IDEA Lab 13537  As a security enhancement, the IDEA Lab URL now uses HTTPS encryption. 

IDEA Licensing 7553  The Authorization code field is validated in the CaseWare IDEA License Manager and CaseWare Network 
License Manager. 

11474  The Authorization code field is validated in the IDEA Licensing dialog box. 

12029 CAS-52138, 
CAS-62054, 
CAS-59137- 
J2F5N5 

IDEA licensing-related error messages have been updated to provide more meaningful information. 

14229, 
14031 

CAS-55949 To improve the user experience in the License Registration wizard, the Copy button (and the associated 
messaging) has been renamed to Copy to Clipboard. 

IDEA Package 
Import 

11116  You can now import multiple files from an IDEA Package file. 

Installation 11679  Installing IDEA on Windows 7 is no longer supported. 

12820, 
12827 

 LZ4 and Zlib have been upgraded to support the removal of Visual C++ 2010 Redistributable from the installer. 

13141  The IDEA installer will no longer install Visual C++ 2010 Redistributable. 

13192 CAS-56514- 
Y0P1D9 

The extracted folder from the self-extracting installer zip file now has a more descriptive, user-friendly name. 

13424  Updated the installer to remove the runsilent.vbs dependency. 



Release Notes 

3/6 

 

 

 

Feature ID Case Description 

Language Browser 8849  A new API, Client.EquationEditor, has been added to the Language Browser. 

Client.EquationEditor allows you to validate criteria in the Equation Editor and returns the equation as a string 
to be used in different tasks. 

Library Window 12563  Similar to the drag and drop functionality in the File Explorer window, you can now drag and drop files from 
the Library window onto other applications. 

Local Library 5981 CAS-14460 You can now configure the Local Library folder location in the IDEA Options dialog box. 

MS Office 2010 7608  IDEA 12 will not support MS Office 2010 as its EOL (end-of-life) was in October 2020. 

Monetary Unit 
Sampling (MUS) 

11950  On the Summary report, if there are no understatements, this information is excluded from the report. 
Only the overstatements information is displayed. 

Project Overview 14352, 

14353 

 When you open your IDEA 11.x and earlier Managed projects in IDEA 12, the Project Overview data file is 
migrated from the SQL Server CE file (ProjectOverview.sdf) to an SQLite file (ProjectOverview.db). 

Python Integration 10849  IDEA is packaged with the Python interpreter, Python packages, and associated files for Python 3.9.2. 

11673  You can now add and edit Python scripts using the Equation Editor. 

12580  On the IDEA Options dialog box, the Run Python scripts check box has been renamed to Enable Python 
integration. 

14064  Performance enhancements were made to our Python integration that enables IDEA to run faster. IDEA no 
longer instantiates a PythonInterpreter instance unless Python is enabled. 

10544, 
10850, 
11672 

 The IDEALib.py custom Python package includes the following enhancements: 

Due to the upgrade to Python 3.9.2, IDEALib.py no longer uses Python.NET. 

New functions have been added to the package. See the CaseWare IDEA Help for more 
information. 

The project_files function no longer lists hidden files and other specific files. See the IDEA Help for 
more information. 

Silent Install 8965, 
9653 

CAS-41389, 
CAS-39381 

New silent install optional parameters let you automatically register an authorization code during the 
installation or automatically connect to a specified CaseWare Network License Server (NLS). 

SmartAnalyzer 10704  SmartAnalyzer (English) is now available in IDEA (Japanese). 

Summarization 14307  Optimized the Summarization task to increase performance. 

14387  The Quick Summarization feature includes the following performance enhancements: 

The 32,000 output record limit was removed. You can now summarize up to 

eight fields. 

All Summarization statistics are now available. 

The Include % in output database and Use fields from last occurrence options are supported. 

User Interface The following enhancements have been made to improve the IDEA user experience. 

  Icon updates were implemented to give the product a more modern look and feel and better represent the 
underlying action. 

10692 CAS-65318, 
CAS-64967 

When the machine that hosts IDEA is connected to multiple monitors, IDEA will now launch the main IDEA 
window and splash screen on the monitor it was last located. If the last known monitor is not available, it will 
launch IDEA on the main monitor. IDEA will always launch in the maximized state. 

11365  With the Data property enabled for the Main window, you can now resize multiple fields simultaneously. 

12030  The following commands have been renamed: 

On the View tab, in the Display group, Freeze Columns is now Freeze Fields. 

On the View tab, the Group group is now Records. 

On the View tab, in the Records group, Group Records is now Group. 

On the View tab, in the Records group, Grouping Off is now Ungroup. 
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Feature ID Case Description 

 12285, 

12286 

 The Library and File Explorer windows contextual menu items were re- arranged for a better user experience. 

12351, 

13030, 

13417 

 The following contextual menu enhancements were implemented on the Main window (formerly known as the 
Database window): 

Available right-click commands are now specific to the UI element (tab, field header, row header, and 
cell) in the Main window. For example, when you right-click a field header, you are presented with 
commands that are field-related (Field Manipulation, Add Field, etc.) 

The following commands have been renamed: Freeze Column(s) is now Freeze 

Field(s) Column Settings is now Field Settings Close All is now Close All 

Tabs 

Show Field Stats is now Show Inline Field Stats. 

On the Data tab, in the Fields group, the Field Manipulation dialog box launcher has been replaced with a 
Field Manipulation command that appears on the tab. 

The entire field is selected when you right-click a field header in the Main window. 

13807  You can now use the middle mouse button to close tabs in the Main window. 

 
Bug Fixes 
 

Feature ID Case Description 

Documentation 9077 CAS-43924 IDEA Help 

   
Updated the Exporting Databases topic to include a note about Microsoft Excel date limitations. 

 9389 CAS-40556 IDEA Help 

   
Updated the Date fields note in the @If topic to state that the TrueResult and FalseResult must be the 
same - either string or date. 

 13287  IDEA Help 

  Updated the Cloud Import Utility link in the Importing CaseWare Accounting Package Files 
topic to point to the appropriate website. 

 12677, 

12678 

CAS-54817, 
CAS-54824 

IDEA Tutorial 

Updated the instructions for the Gallery button and clicking the Y-axis in the View the Results 
Graph section. 

 13373 CAS-57481 CaseWare Network License Server Installation Guide 

   
Updated the Technical Notes section to include information about ports 80, 443, and UDP port 
5093. 

   
The IDEA Installation Guide was also updated to include this information in the CaseWare IDEA 
License Manager Accessibility section. 

@Dtoc 13510 CAS-59632 Resolved a date mask issue. 

File Explorer 13360 CAS-58125 Resolved issue encountered when trying to rename or delete a database that was imported via drag 
and drop onto the File Explorer window. 

IDEALib.py (custom 
function) 

9554 CAS-40849 Resolved issues caused by 0000-00-00 date values. 

12457 CAS-53943 Resolved issue where IDEALib.py could not run in the French and Spanish versions of IDEA. 

Installer 12010 CAS-51803 Resolved issue encountered when a space character is in the IDEAx64install.log file path within the 
installer command line. 

14006 CAS-61847-L8N7Y1 All EXE components have been signed so that they are no longer flagged by security software. 

Language Browser 7481 CAS-33059 Removed case sensitivity in the destination path for 
ProjectManagement.RenameDatabase. 

9082 CAS-39631 Resolved issue where ProjectManagement.Databases ignored lowercase file extensions. 

Library 13359 CAS-58182 Resolved issue encountered when trying to rename or delete a database that was imported using the 
right-click Import command in the Library window. 
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Feature ID Case Description 

Random Record 
Sampling 

11531 CAS-49435-N0D3B7 Resolved issue in the Random Record Sampling History that displayed a "Stratification from:" label 
instead of a "Sampled from:" label. 

Report Reader 11701 CAS-49650 Resolved issues encountered when previewing a database using a registered IDEA product or 
when connected to a CaseWare Network License Server. 

Security 14521 CAS-70582, 
CAS-71187, 
CAS-70713 

Upgraded the log4net.dll so that it is not flagged during vulnerability scans. 

Summarization 11385 CAS-13611, 
CAS-42183, 
CAS-50712 

Resolved issue where the re-run Summarization task does not retain the Create database check box 
state. 

Text Import 9235 CAS-40136 Resolved the empty field creation issue encountered when importing a CSV file that contains a 
comma at the start of a text string (e.g., ", example"). 

12133 CAS-52517 Resolved crash issue encountered when importing a CSV file. 

User Interface 10443 CAS-44068 Resolved issue where changing the font size also changed the font style. 

11075, 
11257 

CAS-47040 Updated old icons in the Field Statistics window, Print Preview dialog box, and the Active Files drop-
down list. 

Visualization 11670 CAS-50199 Resolved a crash issue that occurs when selecting a database when its path (path including project 
name but not database name) is greater than 132 characters. 

An informative error message is now displayed. 

 
Known Issues 

 

Feature ID Description 

Project Overview  Due to Project Overview enhancements in IDEA 12, Project Overview information loss can occur if IDEA 12 Managed projects are 
opened in IDEA 11.x and earlier. 

Summarization 14500 Summarization and Quick Summarization are encountering issues handling Error data and 0 (zero) data. In some cases, Error data is 
displayed as 0 values, and 0 values are displayed as Error. 

 

 

SmartAnalyzer 

The current release provides new app-related features and some improvements of existing 
functions and features available in SmartAnalyzer. Note that the availability of the app- or audit 
test-related features depends on the apps or audit tests you have on your machine and on 
whether they support the new features or not. 

See the New Features and Enhancements topic in the SmartAnalyzer Help available in the File 
tab of the Select and Run and Results and Reporting modules. 

 

This release includes the following new features: 

The complete SmartAnalyzer user interface has been updated to match the updated IDEA user 
interface. The redesigned icons better indicate the underlying functionality and provide you 
with an optimal user experience. 

The new AutomationID tool lets you automate content items such as app workflows and audit 
tests. The tool reads the IDs from the SmartAnalyzer database that contains the content items 
of all the apps you have acquired. You can then select the content item (e.g., audit test) to 
automate, and the tool gets the corresponding ID information required to automate the audit 
tests. 

 

This release includes the following enhancements: Performance improvements: 

There is a significant performance improvement when running analyses if an IDEA project 
contains many files (e.g., more than 5,000 files in one project). There is a significant 
performance improvement when using the Input Assistant to enter parameters for audit tests. 

Default document structure for SAPB. DART feature: 

Validates field names in files that generate an index.xml file. Renames the imported files that do 
not have unique file names. 

The Case Management feature supports corporate structures such as larger entities with their 
subsidiaries. When creating the corresponding audit folder structure in Case Management, a 
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SourcFiles.ILB folder gets generated for the entity and each subsidiary. Therefore, each 
subsidiary's source files are contained in their own SourceFiles.ILB folder. 

 

This release includes the following bug fixes: 

All references to IDEA Server have been removed from the app workflows. Resolved the issue 
encountered when trying to read the audit test resource file. Resolved a licensing issue related 
to the Default document structure for SAPB. DART. 
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